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1 INSTALLATION AND LICENSING 

The installation process for the QC Profiling plugin is both straightforward and quick. Mestrelab Research will provide 
the user with the appropriate license, and only a few steps are necessary to install the plugin. 

• Go to the File tab. 

 

• Click on Advanced Plug-ins… and a new window will open. Select Mnova QC Profiling and click on Install. 

 

• A window will open as in the following figure. Click on OK. 
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• Close Mnova and open it again, and repeat the first step: File >> Advanced Plug-ins…  
• Check if the QC Profiling plugin has been installed correctly. 

 

After checking the installation process, you can start to run your evaluations with QC Profiling! 
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2 INTRODUCTION 

QC Profiling is an Mnova Gears plugin for the automated LC-MS quantitation of DNA labeling reactions. The main 
application of this plugin is for quality control (QC) of the reactions used to generate DNA Encoded Libraries (DEL) for 
drug discovery. 

Ribbon 

 

3 QC PROFILING  

This plugin evaluates the composition of the mixture generated from the reaction between an organic molecule and 
a biomolecule. A set of LC-MS raw data files and the molecular formulas or monoisotopic masses or the reaction 
components in each mixture are required as input. These values are provided in a .csv file, which is later copied, and 
populated with the output of the analysis in the results directory. 

- The main requirement is a .csv file with data organized in rows and columns, as per the figure. 
- The dataset must contain the molecular weights, or the chemical formula of a given compound (yellow 

columns). 
- A column of the .csv file must contain the name of the raw data file (data Id) in order to map it to the csv row 

(red column). 
- Other columns in the .csv file can either be populated with output values or left as in the original file (white 

columns). 
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3.1 Mnova Gears Configuration 

Mnova Gears presents the user with six tabs. For the purposes of the QC Profiling plugin, we are going to configure 
four of them: 

• Input 
• Plugins 
• Output 
• Settings 

To simplify the configuration, this is divided into three steps: Input File Configuration, Output File Configuration and 
QC Profiling Access. 
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3.1.1 Input Files Configuration 

The plugin runs with mass spectrum files provided by laboratory devices. A few important steps must be completed 
before running the evaluation to check the dataset and its configuration. 

- In Input Tab to select a Main Directory for the dataset of mass spectrum files. This is important to identify the 
mask for the files for the following step in the Settings Tab. 

- Click on Select the techniques and experiments that will be used in the analysis and select MS experiments. 

 
- Click on the Filter button and select a directory for the .csv file in the Mapping File requestor. 

 
- Click on Advanced Filter. 

 
 

- In the Advanced Filtering Options match the ID column number with the position of the Data Id in the .csv 
file and select the range of rows for the evaluation.  

- Specify the column with Well plate position and SMILES if available. You can use the Assistant tool to view 
and select the CSV columns.  

- It is also possible to check the option Allow Gaps in Results to include void results with the lines in the filtering 
files. 
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- Go to Settings Tab and define the CSV Separator (“;” is recommended) and check in the Masks Manager 
whether the mask for the Mass Input Files is in the list. If not, add it manually. 

 

 

- After configuring the input files, go to the Input Tab, click on Automatic inspection of the selected 
directory, and verify the results in the new window (figure) to find errors (i.e., the correct settings for all 
the parameters defined in the input tab).  
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3.1.2 Output File Configuration 

Mnova Gears creates a folder to save the QC Profiling evaluation results. This folder also contains some files generated 
by each evaluation, as described in point 3.4.1 Output Folder and Files. 

- Select the Output Directory in which to save the results files. 

 

3.1.3 QC Profiling Access 

The access to the Plugin Settings is the same as any other Mnova Gears plugin. 

1. Go to the Plugins Tab.  
2. Select QC Profiling in the plugins list and click Add.  
3. Select QC Profiling in the added plugins list and click QC Profiling Settings.  
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3.2 QC Profiling Plugin Settings 

The settings for this plugin can be entered in three distinct tabs: 

• MS Evaluation 
• CSV Configuration 
• Report 

3.2.1 MS Evaluation 

This tab provides access to all the parameters that control the evaluation of the LC-MS data used in this plugin.  

The MS Evaluation tab is divided into four further subtabs: 

• General  
• Deconvolution 
• Other Algorithms 
• Color Warnings  
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3.2.1.1 General 

The General tab is used to configure the data that will be used in the evaluation: 

 

 

UV Chromatogram Identification 

This is the algorithm used to assign the main components of the UV peaks, as based on the deconvolution of multiply 
charged ions. 

- UV Trace Label: This parameter is used to define the name of the UV trace within the LC-MS dataset that will 
be used for quantification. To identify the name of the UV trace within the MS Traces, open one file in the 
dataset prior to the evaluation and choose the name of the desired trace. 
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Retention Time Range 

- From, To: Defines the range of chromatogram retention times that will be used for the evaluation. We 
recommend choosing a relatively narrow range, focusing on the retention times where the DNA peaks appear, 
to ensure the best performance of the algorithm for “No Data” detection. 

3.2.1.2 Deconvolution 

The Deconvolution tab is used to configure algorithms for the evaluation and results display. 

 

 

DNA Match 

This algorithm is used to assign the main components of the UV peaks as based on the deconvolution of multiply 
charged ions.  

- Mass Value Type: Average or Monoisotopic. 
- Tolerance: Precision of the Mass Deconvolution. 
- Abundance Threshold: Used to filter out noise from MS spectrum. 
- Charge State Range (From, To): Defines the range of multiply charged ions that will be deconvoluted. 

Charge State Deconvolution 

This algorithm deconvolutes multiply charged ions in a MS spectrum to obtain a deconvoluted spectrum. It is used to 
display the deconvoluted spectra relating to individual UV peaks. 

- Tolerance: Precision of the Mass Deconvolution. 
- Abundance Threshold: Used to filter out noise from the MS spectrum. 



QC Profiling 1.1 | User manual                                                                                                                      

P/N 190 R1.1   Page 13 of 33 

- Charge State Range (From, To): Defines the range of charges that will be deconvoluted. 
- m/z Range (From, To): Defines the range of m/z that will be deconvoluted. 
- Deconvoluted Mass Range (From, To): Defines the mass range (Da) that will be deconvoluted. 

3.2.1.3 Other Algorithms 

This tab completes the previous deconvolution parameters. 

 

No Data Detection 

This algorithm detects datasets where no DNA sample is present, which show characteristic noisy chromatograms with 
very low intensity signal. An associated color warning of such can be displayed. 

- TIC Threshold: Minimum peak intensity to be detected in the TIC spectrum, below which the sample is 
considered to contain no data. 

- Add Comment: Will be written in the Comments column of the output .csv file for the peaks considered to be 
without data. 

Low Mass Peak Detection 

Used to detect UV peaks originating from low molecular weight impurities that must be excluded from the 
quantification. A color warning related to the presence of these impurities can be displayed. 

- Retention Time Tolerance: UV peaks with no TIC within this retention time difference are considered to be 
impurities. 

- TIC Intensity Threshold: UV peaks with a TIC Intensity at the same retention time below this threshold are 
defined as impurities. 

- UV Area Threshold: UV peaks with areas lower than this percentage of the total area are considered to be 
DNA. This approximation is used to avoid wasting time analyzing very small peaks. 
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3.2.1.4 Color Warnings 

Color codes are used to warn the user about the quality of the results by connecting specific issues arising in the 
automation with a color warning. The level of the warnings is configured by the user via appropriate thresholds, which 
allows for a reduction in the number of warnings. 

 

 

- High Peak Purity Threshold: Peaks with an assignment purity, as evaluated via the DNA Match algorithm, that 
is lower than this value. 

- Low Peak Purity Threshold: Peaks with an assignment purity lower than this value. 
- Minimal UV Area Threshold: Peaks with an area below this percentage of total area will not result in 

associated purity warnings. 
- Residual Peaks Warning Thresholds: When the total percentage of residual peaks is greater than this value. 
- Low Mass Peaks Warning Threshold: When low molecular weight impurities are detected. 
- No Data Detected: When peak intensity is low and indistinguishable from noise. Typically, these peaks are due 

to solvents or contaminants. 
- Apply Color Warnings to UV Peaks: Applies the color warning codes above to UV peaks. 
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To select or change the color for each of the above, click on the associated colored square to the right of the definition 
and select your preference in the color window. 

 

Note: selecting white as the color is equivalent to switching off the warning. 

 

3.2.2 CSV Configuration 

Content descriptions of the columns in the input .csv file being used as a template by the application. 
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General Features: 

 Each row in the table describes the content input or output of a column in the .csv file and represents a column 
header from the raw csv file. 

 The dataId, residual and comments rows are always present and cannot be deleted from the table but can be 
moved to match data as appropriate.  

 Practically unlimited input and output columns can be configured by the user, which currently can be one of 
three Data Types: 

- Input: A numeric column in the .csv file describing the molecular weight of a given component. 
- Contents Group: The total composition of a group of input components will be saved as output in the 

.csv file; for example, adducts from the same component. 
- Contents Group Comment: A comment describing how the total composition of a group of input 

components is distributed among the various peaks of the sample. This column is optional. 
 Input and output row from the same component can be highlighted in color for visualization purposes. 
 Rows with no data declaration will be ignored in, but not deleted from the .csv file. 
 The Main Result menu below the table allows the choice of which component in the mixture will be considered 

the main result in the output review options. 

CSV Configuration Tools 

There are many tools to create, edit, move, and remove rows: 

- Add a content 

  
- Add a group of contents 

 

Content Group Name: Final, Final Product, or Starting Material 

Column: is the number for the input/output of the Content Group. 
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Highlight color: white, yellow, lime, cyan, beige, red and orange are available for colored Content Groups. 

Additional CSV Columns: 

− Comment: summarizes the different peaks contained in these groups. 
− Main Peak RT: shows the retention time of the main peak assigned to this group. 
− Main Peak Area: shows the UV area of the main peak assigned to this group. 

 

Note: We recommend that all the Input content columns be created before grouping them. 

- Insert empty row 

 
- Remove selected row: delete a row in the table. Notice that some rows cannot be deleted (dataId, residual, 

and comments). 

 
- Edit selected row: edit any added row in the table. Note that some rows cannot be edited (dataId, residual, 

and comments). 

 

             

- Move selected row up/down: move any row up or down in the table.  
- Magnifying Glass button: inspect the CSV definition of the first lines of the .csv file. A dialog with the overview 

of the first two lines will appear, showing the content of this file relating to the definitions given by the user. 
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Note: the following chapter gives a step-by-step explanation of how to create a table. 
 

3.2.3 How to create a table 

After configuring Mnova Gears and QC Profiling Settings, the user can create a table that maintains the CSV file 
structure, as per the following example: 

1- Add Input columns:  

Click on Add a content to enter new content and select each desired column. For this example, we are going to add 
three contents for each input group, “Final Product” and “Starting Material”. 

Final Product Rows: FP1, FP2, and FP3. 

 

Starting Material Rows: SM1, SM2, and SM3. 

 

Note: Remember that each row of the table matches a column in the .csv file. 
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2- Create an Output group for each content group:  

Click on Add a group of contents to create an Output Content Group.  

In this case, we are going to create two Content Groups. The first group is configured as per the following figure for 
Final Product contents. 

 

 

The same process can be repeated with Starting Material contents, selecting a different Column, Highlight Color, and 
Comment column. 
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Added groups will be displayed in the main table 

 

After creating the table, we need to ensure that the rows from the table match the columns of our .csv file. 

3- CSV inspection:  

Click on the Magnifying Glass button to open the CSV File Columns Overview and inspect.  

 

Select Main Result: 

Open the Main Result menu, choose Final Product and click OK or continue with QC Profiling configuration. 
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3.2.4 Report 

Define the number of MS Spectra Extractions and Layout Template to apply in the output Mnova Files.  
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MS Spectra Extractions 

- Maximal Number Of Extracted MS Spectra: Define the number of MS Spectra for the report. 

Layout Template 

No template and two default templates are available in the plugin; a custom mode is also available to configure the 
report according to user preferences. 

- None 
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- Default Portrait  

 

  



QC Profiling 1.1 | User manual                                                                                                                      

P/N 190 R1.1   Page 24 of 33 

- Default Landscape 

-  

 

- Custom 

The user can load their own Layout Template, which can be created in Mnova. Find the directory with a saved custom 
layout template file and load it into the plugin. 
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How to create a Layout Template report and save it: 

- Open a QC Profiling report, for example with the “Default Portrait” template, and place the objects on the 
page as desired.  

 
- Go to the View tab. 

 

- Click on Layout Templates. 

 

  



QC Profiling 1.1 | User manual                                                                                                                      

P/N 190 R1.1   Page 26 of 33 

- Select Create Layout Template Document and save the template in your preferred directory. 
- The content of all page items is removed to leave a pure template with the user’s desired placeholders. 

 

- A new Layout Template is created and made available in the template list, and can be loaded as a Custom 
Layout Template in the QC Profiling report settings. 
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3.3 Save and Load Settings 

Saving your settings in files can save a lot of time the next time the automation is executed. These files can also be 
used to exchange settings with other users within your organization or with our Mnova Support Team. Settings can be 
saved and loaded using two different functions, each saving a different form of settings file: 

• “.mgrs”: contains Mnova Gears and QC Profiling settings. This can be saved or loaded from the Mgears 
window. 

 

Note: Each evaluation generates an .mgrs file in the output directory  (3.4.1 Output Folder and Files). 

• “.data”: contains QC Profiling settings. This can be saved or loaded from the QC Profiling Settings window. 

 

Load saved settings files, “.mgrs” or “.data”, to simplify the plugin configuration and modify them as required to save 
time. 
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3.4 Results 

During the evaluation, a new directory is created in the output directory declared in Mgears. This directory carries a 
time stamp for the start of the evaluation. All the results generated during the evaluation are created there. Among 
these results, the most important are illustrated in the following point. 

3.4.1 Output Folder and Files 

Each evaluation generates a folder as per the figure, named according to its own time stamp. 

Within this folder, the user can find the evaluation results, such as different types of files and some important files 
types: 

 

 Mnova Files: open the “documents” folder and click on any file. A window similar to that in the figure below 
will open and the user can use Mnova tools to analyze the report document. 
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 HTML File: click on QCProfiling-Results.html and a website will open in an internet browser window. 

 

Opening this file allows you to: 

- Get a brief inspection of the results. 
- See small descriptive figures of the results. 
- Download Mnova files through links. 
- Sort the results by different column names. 
- Find any file with the Search tool. 
- Copy the website link and share. 
- Create simple reports in .csv or .pdf format. 
- Print the results. 
- Select the columns to show on the website. 

This file is available for any device such as PC, smartphone, or tablet that can run an internet browser.   
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 CSV File: open the “QCProfiling” folder. A copy of the input .csv file is saved in the QC Profiling directory of 
the output folder. This file is populated with all the output from the evaluation using the settings defined in 
CSV Configuration (3.2.2 CSV Configuration).  

 

 .log File: this file summarizes the entire evaluation. Any error will be reported and consulted on in this 
document. 

 .mgrs File: this file contains all the evaluation settings to allow them to be loaded again into QC Profiling Plugin 
Settings (3.3 Save and Load Settings) for the following evaluations. 

3.4.2 Mnova Viewer 

The results can be analyzed with the Mnova Viewer, which is a fast and easy way to check the output dataset, make 
modifications, and analyze again, if needed. 
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Load the results folder and open in Mgears Viewer. 

 

Mnova Viewer Options: 

Peak Assignment modifications  
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After each modification, click on Analyze Again to reassign peaks (highlighted red in the figure below). 

.  

If you prefer or need to make manual assignments, you can use the Modify UV peaks assignment manually option 
(highlighted in blue in the figure above) 
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You can save after each modification manually or choose autosave if you prefer to allow a faster results inspection. 
Click on Settings and select Save Automatically on Clicking Analyze Again in the Mgears Viewer Settings window. 

 

 

 

 


	1 Installation and licensing
	2 Introduction
	3 QC Profiling
	3.1 Mnova Gears Configuration
	3.1.1 Input Files Configuration
	3.1.2 Output File Configuration
	3.1.3 QC Profiling Access

	3.2 QC Profiling Plugin Settings
	3.2.1 MS Evaluation
	3.2.1.1 General
	3.2.1.2 Deconvolution
	3.2.1.3 Other Algorithms
	3.2.1.4 Color Warnings

	3.2.2 CSV Configuration
	3.2.3 How to create a table
	3.2.4 Report

	3.3 Save and Load Settings
	3.4 Results
	3.4.1 Output Folder and Files
	3.4.2 Mnova Viewer



